RIP Browser:
Embrace the Chrome Over

Saying Goodbye is the Right Thing to Do
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What is a browser?

View specified content
(by you via URL)

* View — Only for looking

* Specified (by you) — Good luck
finding it (spam)

 Content — Whatever, however, and
whomever decides for you

* Chasing rabbits (links)

* What if only a small part of the page
IS relevant?

* Tab explosion?




Conclusion and Next?
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* The name “Browser” is spot on.
lviewed it Demonstrates its shortcomings!

my wayeee!

* Furby’s and browsers were great in the 1990s, but...
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* For my workflow, | need a digital ally...
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Al Browser
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* Enter the new contender...the Al Browser
* Much more than a ChatGPT webpage
* Integrated Intelligent Assistant

 All browsers will become Al browsers or die

G comet )

Dia May need Pro account. Fellou
Student/educator free month?
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Have a conversation with Al about current tab or even selection

Inbox - rosiedewba...
mail.google.com/m...
Application for Director of Curatorial Affairs

careers@noguchi.org make this sound more confident

Application for Director of Curatorial Affairs

& write ® copy
Dear Noguchi Hiring Committee,
| am excited to apply for the Director of Curatorial Affairs position at The Isamu With a proven record of curatorial
Noguchi Foundation and Garden MuseumRIVith a proven record of curatorial leadership, exhibition planning,

leadership, exhibition planning, collection management, and research, | am

g s collection management, and
certain | will be a valuable asset to your team.

research, | am confident | will make
My career is defined by a commitment to innovative curatorial practice, an immediate and significant impact
advancing scholarship, and fostering inclusive public engagement. | have led
multidisciplinary teams, developed dynamic exhibitions, and built strong
relationships with artists, scholars, and community partners—experience that
directly aligns with the requirements of this role. The Noguchi Museum’s mission

to contextualize and extend Noguchi’s legacy resonates deeply with me, and |

on your team.

diabrower.com

© @ SansSerif v 7T+ B I U A~

Ask another gquestion...




Context Over Multiple Tabs

Important meeting inbox x e @

4 Summarize this email

, Jeff Donahoo B56AM (3 minutesago) v¢ @ &

tome

| hope this message finds you well. As we navigate an ever-evolving business
landscape, it is essential that we continuously evaluate and adapt our strategic direction
to ensure sustainable growth, innovation, and long-term success. With this in mind, | am
excited to announce that we will be revamping our company's overall strategy to better
align with our vision, mission, and the opportunities ahead.

When are you available over the next week to create a framework for this discussion?

[Message clipped] View entire message

| | am available anytime. | | How about tomorrow afternocon?

| We can meet next week. |

lj:' “ Reply ':jl [:. + Forward

Q

+

Write a response to this email.
Include the times I'm available next
week using

& Week of September 1...

Thought for 3 seconds >
= Text D) Copy

Thank you for reaching out and for
sharing your vision for our company's
strategic direction. | appreciate the
opportunity to be part of this important
conversation.

Regarding availability next week, | can

meet during the following times:
- Monday, September 15: 12:00 PM -
1:00 PM; after 6:00 PM

« Tuesday, September 16: 10:30 AM —
1:00 PM; after 3:30 PM

- Wednesday, September 17: 12:00 PM
- 1:00 PM; after 3:30 PM

« Thursday, September 18: 12:00 PM -
1:00 PM; after 3:30 PM

« Friday, September 19: Before 8:00
AM; after 1:00 PM
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Double check
results!

Al may
confidently give
a bad list of
availability.



What was that part about... IlHI DATA & Al
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Watching video on Excel. Somethingis not working. | recall something about making my data a table.
Multimodal - Can work with text, audio, video, etc.

@ oo @) B 9D [l ® Reduced Kevin_Cookie_Company_Sales_Data_for_Pivot_Table_Demo_ + Saved v X e
File Home Inset Draw Pagelayout Formulas Data Review \View Automate Developer Help Power Pivot  PivotTable Analyze  Design = Comments o
e 0T B I U.-Ee 6 A EEEEE Evecacr $-% 9 @R Conduom formuts Cel E] &~ Fhue dts . To convert data to a table in
Clpboss 5 5 C 5 A * Excel, select your data and use
B4 v i S 14385 v .
n the Insert > Table option.
A B C D E F G PivotTable Fields WX
1 T T e @ Here's how you can convert your data to a
) — table in Excel, as explained in the video:
3 Rowlabels  Sum of Sales Amount
. B sulespersen Step-by-Step: Convert Datato a
4 |Alice | $14,386 - bl
5 Bob $11,367 Do
6 Charlie $11,085 i':' ‘:W”‘ 1. Select Your Data
7 Eve $10,920 ik o Click and drag to highlight the range of
8 Diana $10,6$6? cells you want to include in your table.
‘,um of Sales Amount Dirag fields between areas below ake sure YQU[ ata as column
9 Grand Total $58,¢ > Mak data has col
10 Row: Diana T Filters I Columns headers at the top. 00:15
11 2. Go to the Insert Tab
12 o At the top of Excel, click on the Insert
13 e tab. = 00:36
* || Sum of Sales Amount
14 3. Click on Table

s J o |n the Insert tab, find and click the
3:44/ 8:35 - Add Region Data to Pivot Table » Table button. Excel will automatically

=3
yjun

select the data range you highlighted.
Pivot Table Excel | Step-by-Step Tutorial 00:41
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Spit Screens (not tabs) - Dia

= Microsoft Blng &y Copilot Images Videos Shopping Maps R About  Store Gmail Images ] (‘

Google

. _ o
Q© ‘Hay' there! r( .
= — ) -~ - e

|
& Freed from captivity in Iraq ¥ Body inside impounded Te...

Google Search I'm Feeling Lucky

Y

1®

4. :‘. .
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e e “ % Boue: B vint: B mild Airb + v
< 4 Dia Personalize Off

m GUES!Ready - Stun
g Vintage House by t

MilG Beachfront Ca...
airbnb.com/froomsy...

compare these Airbnbs in a chart. which is closest to the beach?

Mili Beachfront Casa da Rampa is the closest to the beach,
just a 2-minute walk away.

diabrower.com

Here's a comparison chart of the three Airbnbs in Colares, Portugal:

Property  Price (5 Bedrooms Max Guests Distance Notable Avg.

Name nights) to Beach Features Rating
(Reviews)

Mila $2,970 5 8 2-min Sea 4.71 (17)

Beachfro walk views,

nt Casa (partially large

Ask another question... O



Search and Summary
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< ¢  teklafabrics.com

W

Organic cotton in a compact yet lightweight weave

Beach towel

T Beach Towel - Moro S

llﬁl

Beach Tt .

T Beach Towel - Mor...

tekiafabrics.com/pr

find me a cheaper version of this
beach towel that doesn't look
cheap

Read parachutehome.co...azon.com, and 4 more v

The best affordable alternative
to the Tekla Moro Stripes
beach towel is the Brooklinen
Cabana Stripe Beach Towel at
$58, which looks and feels
luxe.

If you want a beach towel tl

chi

diabrower.com
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Automation and Agentic Al
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* Go beyond prompt + response

e Automation: Task with defined steps where Al makes decisions (e.g., Happy or
Angry Email)

* Agentic: Al system that, given a goal, can plan and execute a multi-step task



Automation

e Dia Skills
/make-ad

[SKILL]

Generate high-converting ad copy
using a web page or provided text for
platforms like Meta, Google, or
others.

[ROLE]

You are an expert advertising
copywriter, skilled in frameworks
such as AIDA, PAS, and other proven
methodologies. You analyze the
provided web page or text, extract key
value propositions, and craft
compelling ad copy tailored to the
requirements of the chosen ad
platform (Meta, Google, etc). You
always clarify the intended platform
and ad format before generating

copy.
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On diabrowser.com

/make-ad

Thanks for sharing your goal and the Dia

Browser web page. To create high-converting

ad copy, | need a bit more detail:

1

Which ad platform are you targeting?
(Meta/Facebook, Google, Linkedin,

Instagram, etc.)

. What ad format do you want? (Single

image, carousel, search ad, video, etc.)

. Who is your target audience? (e.g.,

students, professionals, tech

enthusiasts)

. What is your main campaign goal?

(e.g., sign-ups, downloads, awareness)

. Any specific tone or unique selling

points you want emphasized?

Once you provide these details, I'll generate at

least five distinct ad copy options, each using

a different proven framework and tailored to

your chosen platform and format.

Let me know your preferences, and I'll get
started!

Instagram, single image, university
faculty, awareness, motivating

Results

Platform: Instagram

Ad Format: Single Image

Target Audience: University Faculty
Campaign Goal: Awareness

Tone: Motivating

Copy Option 1 (AIDA):

o Headline: Transform How You Work Online
o Description: Imagine a browser that's more
than just a window—Dia is your Al-powered
partner for writing, planning, and research,
right in every tab. Discover a smarter way to
teach, collaborate, and create.

o Call-to-Action: Get Early Access

Copy Option 2 (PAS):

o Headline: Struggling With Digital Overload?
o Description: Endless tabs, messy notes,
and lost ideas slow you down. Dia Browser
streamlines your workflow so you can focus
on what matters—your students and your
research.

o Call-to-Action: Tre Dia Todaw

Skills Gallery

/daily-wrap

Summarizes your last 24
hours of work.

@ Malay Vasa

See more

Try in Dia



Fellou — Agentic Al

i (NK] a R) a Amazon Fresh Groceries
™) Set Fellou as default browser [ESEEReSETIL

ama;on @ DN::I:{I;&:;;Z1Z Amazon Fresh ¥ = Search Amazon Q

= Al m Amazon Haul Same-Day Delivery Medical Care ~ Luxury Stores

Past Purchases  Repeat Items  Alexa Lists Savings v+  Explore v  Aisles +  Bac

Delivery ~ FREE Pickup ~
Today, by 2-4 PM — 37212 Today, at 1-2 PM — Nashville

G Reserve a time

Beat
halftime
hunger.
Shop football »

Buy it again

llﬁl
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recipes from the open webpages to
understand taste preferences

<% Code Agent = Create 5-day dinner plan

with recipes under 700 calories per serving

<¥ Browser Agent  Add all shopping list

items to Amazon Fresh cart

adding the

B navigate_to
Nav

¥ Task in progress. Feel free to switch chats.
I'll notify you when it's ready.
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Fellou Features
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* Deep Search Functionality: Search43+ platforms, including public and private
sites and generate summaries.

* Cross-Platform Automation: Automate multi-step workflows on sites like Gmail
and LinkedIn.

* Desktop and File Integration: Interact with local files and applications, organize
desktop files, run system tasks, and even handle logged-in platforms securely,
bridging the gap between web and desktop automation

* No-Code Automation: Use drag-and-drop interactions or natural language
commands to create complex automations

* Scheduling and Recurring Tasks: Users can schedule tasks to run automatically
at specific times or intervals

* Agentic Memory: Continuously learn from user interactions, preferences, and
historical data to deliver personalized assistance




Comet Features
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* Agentic Browsing and Automation: Autonomously navigate the web and
execute tasks on your behalf

* Intelligent Tab and Workspace Management: Automatically grouping open
tabs by topic and creating self-organizing workspaces that save and
categorize research sessions for later resumption.

* Personal Knowledge Graph: Connectyour accounts (e.g., Gmail, Google
Drive) to build a personal knowledge graph to tailor assistance to your

unique context, providing synthesized answers and recommendations
based on your history and preferences.

* Spaces: Knowledge hubs where related searches, threads, and files are
organized as a centralized repositories for specific projects, topics, or
teams.




Why local and not cloud/web? Iuﬁl BELMONT,
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Local browser...

* is already logged on to sites and even local tools.
EX: Write email and put it into Outlook desktop app.

* is aware of your local context such as tabs open, history, etc. (beware
what you share)

* can find my Linkedln requests and then accept all.

A webpage on ChatGPT is not!!
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* Embrace: Actively approach your day through an Al lens.

* Experiment: Try it out! Easy to experiment with an Al tool by simply seeing

what happens. You might discover a great solution, and even if you don’t,
there’s little to lose.

Transforming the Browser is becoming mainstream
* Microsoft Edge started integrating Copilot

* Google has announced Gemini integration with Chrome

Don’t wait. Be with the “IT” crowd. Engage your Intelligent Assistant now.



Questions or Comments?
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